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Tutorial

A number of tutorial examples are provided on disk.

Example 1 RC Filter
Example 2 Transistor Amplifier
Example 3 Hybrid PI Amplifier
Example 4 Transformer Stage
Example 5 Elliptic BandPass Filter
Example 6 FET Amplifier
Example 7 Twin-T Filter
Example 8 Single BPF
Example 9 Delay Line
Example 10 GIC LPF
Example 11 Transmission Line Transformer
Example 12 Stub Tuner



The Index contains a list of all Help topics available for the Help Example. For information on 
how to use Help, press F1 or choose Using Help from the Help menu.



Tutorial

A number of examples are included on the disk.

They will provide the most ideal method of learning ACIRAN. Enter the first one from the 
keyboard. 

To enter a circuit select New and enter a circuit name. This is for your benifit only, and 
appears in listings.

Next you will see a dialog box of component types, use the normal selection methods to 
choose a component type. If    the    component type is Fet, Opamp or Transistor you will be 
asked if you wish to load model parameters from disk. If you select to do so you will be 
presented with another file selection box, to choose the component model. More about this 
later.

All resistors are 1% and all capacitors 10% unless stated otherwise.



Example 1

The circuit is shown below:

RC Filter.
                          
node 1                                                                                                node 2
    0--------- R1 ----------------o-------------------------0
                                                                      |
                    100 +/- 0.5%            |
                                                                    R2      10 +/- 2%
                                                                      | 
      INPUT                                              |                          OUTPUT
                                                                      o node 3                          0
                                                                      |
                                                                      | 
                                                                    C1    0.001uF +/- 10%
                                                                      |
            node 0                                      |
    0_________________o________________0

Select New from the File Menu.
Enter the circuit description 'RC Filter' <cr>.

When    the Select component box is displayed,choose a resistor, and a form will appear on 
the screen ,you will be asked for the component identifier, enter 'R1' and press <TAB> ( Up 
to 5 characters can be entered for the component identifier).

You will now move to the next input field, you will then be asked for the value of R1. Enter 
100 <TAB>.

You will then be asked for the tolerance in %. Enter 0.5 <TAB>. (The leading Zero is 
essential).

Next you will be asked 'From Node', Enter 1 <TAB>, and then 'To node', Enter 2 <TAB>.

The convention in ACIRAN is that the INPUT NODE is ALWAYS 1 and the GROUND NODE is 
ALWAYS 0. The OUTPUT NODE is variable.

Once you have completed the form you must press enter or click the OK button to exit and 
save you data.

If you press Cancel the data will be ingored. You can move around the input form changing 
the information using the edit keys, until you are happy with what you have entered. 
Previously entered data that is presented and can be accepted by entering <cr>.

Enter component R2 in the same way. To enter C1 select Capacitor, and for the value enter 
0.001u. the 'u' or 'U' at the end tell ACIRAN that the value is in microfarads.

For more information on input format refer to the multipliers section.

Now that the circuit has been entered click Cancel in response to next component and you 
will be asked for the Output node.

If you press <cr> without entering any data ACIRAN will assign the highest node used to the 



output node. In this circuit this is not the case and you must enter 2 <cr>.

It is advisable to save your work and so as soon as the main menu returns press Alt-F for File
then Alt-S for Save, or use the mouse.

When asked for a file name enter any valid filename, remember to omit any file extension.

You can check your circuit configuration by selecting NetList. The circuit listing is displayed. 
You can scroll through it using the scroll bar on the left of the window, or by pressing the 
up/down arrow keys or PageUp and PageDn keys. To Print the data select Print from the 
windows system menu.

Check that the circuit connections are correct.

If you do not wish to enter the circuit yourself you can load it from the disk by selecting 
Open at the main menu and loading 'EXAMPL1'.

Now analyse the circuit by Selecting Analyse at the main menu.

A frequency input form will appear, you must complete at least the first three entries, some 
have minimum default values already loaded.

You can select Log or Linear sweep from the Config box, the default is Log. For the moment 
leave it as Log.

Now enter the start frequency. Enter 100k and press <TAB>.

Enter End frequency 100M (note capital 'M' for Megahertz).

Finally enter the number of frequency steps, 10 <cr>.

Leave the default number of passes as 1. Remember to press return or click OK once you are
satisfied with the input data.

If however you enter a number of Passes > 1 then ACIRAN will analyse your circuit that 
number of times, and on each pass it will vary the component values within the tolerance 
limits you specified for each    component.

ACIRAN will now analyse your circuit from 100 kilohertz to 100 megahertz in 10 Logarithmic 
steps.

The Sweep mode selected will remain in force in future analysis unless you specifically 
change it. During Analysis the    frequency sweep mode and range are displayed and a 
counter shows the percentage of the analysis completed.

You Can abort the run by pressing Escape or clicking on the Cancel button. In either case you
will get a    message when the analysis is over.

NOTE: Due to the numerically intensive nature of this program there may be a few seconds 
delay between the user aborting the run and Aciran recognising the abort message as it only
checks the message queue once during each frequency pass.

Select Results to see a table of results. Only Gain, Phase and Time Delay are shown by 
default, to see impedance or return loss you must check the boxes in the Config dialog box. 



Close the Results window, or minimize it. Select Graph and choose Magnitude. If your printer
has Graphics capability you can obtain hard copies by selecting Print from the system menu 
of the Graph Window.

Transmission Results for RC Filter - See Printed Manual

Monte-Carlo

Select Analyse again, but this time change the number of tolerance passes to 3 . It is not 
necessary to enter the Start and End frequencies again,or the number of steps, as ACIRAN 
will remember the previous values. You can however change any one of them (or all) if you 
wish. It is only necessary that you do not try to violate the input requirements (such as End 
frequency coming before Start frequency or a Log sweep on too small a frequency range).

Keep the same frequency range and number of steps as before, and so enter <TAB> for 
each entry. This time during Analysis the window text shows the current Monte-Carlo pass 
being executed. At each pass the circuit is analysed using component values selected at 
random from within component tolerance limits.

After analysis ACIRAN will output the results but this time the heading Upper Limit appears. 
This shows the upper limits reached during the Monte-Carlo passes. The Lower Limits are 
printed next. If you select Graph you will see not one but two graphs showing the spread of 
results obtained. This tolerance analysis lets you see how your circuit is likely to vary in 
performance due to component tolerances. In this example only 3 passes    have been 
selected but in practice several hundred passes may be needed to give a representative
picture.

However this would take a lot longer and for large circuits the time can become excessive 
especially if there are a large number of frequencies.

 
Further Examples

You have now covered most aspects of ACIRAN with the exception of MODELS.

How to create your own MODELS using any wordprocessor is explained in the
Appendix, for the moment simply examine how you can use the ones supplied on
the disk. To do this look at some more examples which make use of MODELS.



Example 2

The next circuit (EXAMPL2 on the disk) uses a single transistor in a common emitter 
amplifier, and is shown below:

Transistor Amplifier circuit -- See Printed Manual for schematic.

Note that both power supply rails are numbered node zero. This is because as far as AC 
analysis is concerned the power supply is an AC short circuit, normally due to decoupling 
capacitors. You could add a DC Voltage Source which is included for compatibility with 
PSpice. The Voltage source will be treated as a short for AC Analysis purposes.

Enter the circuit as shown. When you select component type Transistor you will be asked if 
you want to load model parameters, select YES.

You will be presented with a filebox similar to the type used for loading circuit files, select a 
'BC107'.

If you enter NO for loading a model file    ACIRAN will assume that you are unable to supply a 
model file and will ask you for details of the transistor which must be entered from the 
keyboard. 

In either case once the Transistor parameters are loaded you will be    presented with a 
Transistor Form, most of the details will be filled in if you loaded model parameters from disk
(This is also true for FET and OPAMP) model files). You must enter a circuit identifier,(this is 
needed to select the component from a Pick List during subsequent edit operations), also for
the Base, Collector, and Emitter node connections, and these should
be entered with reference to the above circuit.

The default collector current is 1mA, this can be altered once you have calculated the DC 
current.

Analyse the circuit from 10 hertz to 10 Megahetrz in 10 Log steps. The resistor R5 is not 
needed by ACIRAN but was added so that the results of the ACIRAN analysis could be 
compared with the output from a proprietary Circuit Analysis package that runs on a Vax 
under VMS4.6.

The results compared almost exactly at low frequencies and only at higher frequencies could
any significant differance be spotted.

This is due to the type of transistor model used by ACIRAN which is a simple model requiring
only 3 nodes. A more precise model can be used which requires one extra node for each 
transistor, and the same circuit using just such a model is illustrated in EXAMPL3.

Transistor Amplifier Results - See Printed Manual



Example 3

A Transistor can be modeled using the Hybrid PI model as show below:

Hybrid PI Model -- See Printed Manual for schematic

The three nodes B,C,E are the same as before,however an extra node b' is needed to model 
the Transistor base spreading resistance. The parameters shown can be calculated from    
manufactures test data and are dependant on the small signal 'h' parameters, the transition 
frequency FT, collector current and the transistor internode capacitances.

In EXAMPL3 the BC107 transistor has been modeled in this way. Methods of calculating the 
Hybrid parameters can be found in the Appendix. The only new component type is the 
voltage controlled Current Source 'gm'.

The Source is a four terminal device which can be used to model all kinds of active devices 
such as Fets and Opamps. The From node is the current source,in this case the Collector, 
and the To node is the current drain. The + control node is the drive source for the current 
generator, here the Base, and the - control node is the drive sink, for a CE circuit it is the 
Emitter.

Analyse EXAMPL3 over the same frequency range as EXAMPL2 and examine the differences.



Example 4

This is a simple transformer coupled stage connecting a 50 ohm source to a 1k load. As 
ACIRAN references both Input and Output to ground it is necessary to connect the 
transformer primary and secondary windings to ground for analysis. In practice these 
connections could be omitted to provide DC isolation.

In transformer coupled amplifier stages where the second stage is referenced to ground 
there is no problem and the transformer can be connected as normal.

As stated before ACIRAN models Ideal transformers, whereas in reality transformers have 
winding resistance and inductance.These imperfections are modeled by adding resistors and
inductors to the circuit as shown below.

Transformer Coupled Stage See Printed Manual for schematic.

RP and RS are the primary and secondary DC winding resistances for the transformer. The 
inductors LP and LS simulate the transformer inductances. The primary has 1000 turns and 
the secondary 1080, therefore as a ratio to one is required, enter 1.080 into the transformer 
form at the ratio field.

Analyse the circuit from 20 to 20k in 10 Logarithmic steps.

Transformer Stage Results - Stage See Printed Manual.



Example 5

This is an Elliptic-function Bandpass Filter. The filter is to work into a 10K Load from a 10K 
Source. Select Config and check ReturnLoss.

You should then change the source and Load referance impedances,Zin and Zout, the 
default is 100Mohms real. You can change these to 10K real and 0 ohms imaginary.

Quit Config and analyse the filter. The filter has a passband from approximately 15khz to 
20khz. Using a Linear sweep examine the response from 12khz to 24khz in 10 steps. Notice 
that the filter response changes sharply below 15khz and above 20khz. Now examine the 
response from 15khz to 20 khz in 40 steps, in order to see how much ripple exists in the 
passband.

Elliptic-Function Bandpass filter See Printed Manual.

Transmission Results for Elliptic BandPass Filter -    See Printed Manual.



Example 6

This is a VHF/Video amplifier using an FET.The circuit is show below:

Again note that both power rails are at node 0. 

Analyse the circuit from 1M to 200M on a Log sweep.

Fet Amplifier Results - See Printed Manual.



Example 7

This example is of a Twin-T notch filter and illustrates the use of an Opamp.

The circuit is shown below:

Twin-T Filter See Printed Manual for schematic.

Analyse the circuit from 10 hertz to 2k hertz in 10 Linear steps.

Note that the notch frequency occurs at about 1khz.

Twin-T Filter Results - See Printed Manual.



Example 8

This is a Single Bandpass Filter section. It has a response curve which is the inverse of 
exampl7. It is designed to have a centre frequency of 3.6khz and a 3dB bandwidth of 60Hz. 
Analyse the circuit on a Linear sweep from 3.0khz to 4.5khz in 10 steps.

Note that R6 is variable in order that the circuit response can be finelyadjusted.Experiment 
by changing the value of R6.

Single Bandpass Filter Results - See Printed Manual.



Example 9

This circuit is an active delay line with a gain of 20dB and a 100uS constant within 3% to 
3khz. Up till now the circuit Amplitude has been of paramount importance, but this is not 
always the case. The Time or Group delay has an important part to play especially in 
telecommunication circuits where poor Group delay response can introduce distortion. 

It is also possible to look at the open circuit input and output impedance.

In this example select Config and then select Cartesian format. Do not change the referance 
impedance from the default of 100Mohms.

In this example the circuit provides not only gain but almost constant Time-delay for 
frequencies up to 3khz. 

Analyse the circuit on a Linear sweep from 100hz to 3khz.

100uS Delay Line - See Printed Manual for schematic and results.



Example 10

This is quite a large circuit and demonstrates how ACIRAN can handle even the most 
complex analysis.

LowPass Filter See Printed Manual for schematic.

The circuit is a five stage GIC Elliptic-function Low Pass filter. It is to have low insertion loss 
and ripple in the pass band up to 260Hz, and to have a minimum attenuation outside the 
passband of 60dB at 270Hz.

In practice variable resistors are needed to adjust the GIC to obtain the desired response.

Analyse the circuit from 100 to 300Hz in 10 Linear steps. This circuit may take several 
minutes to Analyse.

Low Pass Filter Results - See Printed Manual.



Example 11

This example uses a Transmission line as a quarter wavelength transformer to match an 
impedance of 95 ohms real to a load of 50 ohms real. The frequency of interest is 150Mhz 
(2m wavelength) which gives a line length of 50cm (2m/4).

The impedace of the line to give the required match is equal to the square root of the source
impedance multiplied by the load impedance ie.

                sqrt(95 * 50) = 69ohms
          
Transmission Line Transformer See Printed Manualfor schematic.

Where Zo = characteristic impedance
                      L    = length in cm
                      Er = relative permeability

The configure menu is entered and the load impedance set to 50 + j 0.00 and the generator 
impedance to 95 + j 0.00. Select Return loss and Linear Sweep.

Analyse the circuit from 148Mhz to 152Mhz in 4 steps, the results are:-

Transmission Results for Transmission Line Transformer - See Printed Manual.



Example 12

This example makes use of transmission lines to match a source impedance to a complex 
load by means of a Stub Tuner. The theory of Stub Tuner matching is beyond the scope of 
this manual and the reader should refer to relevant text books.

Stub Tuner See Printed Manual for schematic.

 A Stub can be open or short circuit, it is better to use a short otherwise it tends to radiate. 
The circuit was analysed over the same frequency range as before. The source generator 
was set to 50 + j 0.00 ohms and the load set to 100 + j 50.00, ie complex.

Transmission Results for Single Stub Match - See Printed Manual.

Where Zo = characteristic impedance
                      L    = length in cm
                      Er = relative permeability

At first appearance the passive line seems to have a gain, this is due to the impedance 
transformation, and although a voltage gain is produced the current gain is less than unity 
and so is the power gain.



Multipliers

A number of multiplier options are allowed and upper or lower case can be interchanged in 
all cases except 'M' and 'm'.

The multipliers accepted by ACIRAN are

     'G' or 'g'            Giga          =      x1E9
      'M'                          Mega        =      x1E6
      'K' or 'k'            Kilo            =      x1E3
      'm'                          milli            =      x1E-3
      'U' or 'u'            micro        =      x1E-6
      'N' or 'n'            nano          =      x1E-9
      'P' or 'p'            pico          =        x1E-12

These multipliers can be entered in a number of formats, eg 1k2, 1K2,1.2K, 1200, 12e2,12E2
and 1.2e3 are all acceptable and identical .



Format

Format allows you to select the format used for impedance results. A choice of Polar or 
Cartesian coordinates is available.

IF you select    Polar (this is the default setting) then impedance results will be output as a 
Magnitude and Phase angle. On the other hand if you select Cartesian then impedance 
results will be output as a Real and Imaginary part.



Sweep

Sweep allows you to change the sweep mode (Logarithmic or Linear). If you    start a New 
circuit the Sweep mode defaults to Logarithmic. 



Options

Impedance and ReturnLoss calculations are automatically performed but they are not 
displayed unless checked in the config box. Tolerance simply toggles the Tolerance entries 
flag on and off. All the components will originally have 0% tolerance but you can change this
by using the Edit Change feature.

Tolerance toggles on and off the Toleance flag, This determines if component tolerances will
be taken into account during Monte-Carlo analysis.

Beep allows you to turn off the warning beeps that are issued by ACIRAN should you not 
wish to disturb others. The only exception is the case where you are about to exit ACIRAN or 
load a new circuit, and have not saved your work.



Reference Impedances

Generator
This option allows you to set up the source reference impedance. You may enter values in 
the same format as that used for resistors (ie multipiers are accepted).

Load
This option allows you to set up the load reference impedance. You may enter values in the 
same format as that used for resistors (ie multipiers are accepted).

ReturnLoss is calculated with respect to the input and output reference impedances. The 
default is 100Mohm real for both input and output. This means that your circuit is analysed 
without taking into account the effect of realistic source and load impedances.

You can change the Source and Load referance impedances to more practical values and 
Input and Output impedances will be calcuated taking these referances into account, or if 
you leave them unchanged you will get the open circuit input and output impedances 
without loading effects. Once you have changed the reference impedances they will remain 
changed until you load or enter a new circuit, or specifically alter them. ALL config options 
are saved along with the circuit data to save having to change it every time the circuit file is 
loaded.



Edit Menu

The Edit menu includes commands that enable you to move edit your circuit by adding, 
deleting, and changing components.

For more information, select the Edit menu command name.

Add Adds new componts to circuit.
Change Changes component parameters.
Delete Deletes a component.
Name Renames Circuit.
OutputChanges Output Node.



File Menu

The File menu includes commands that enable you to open and save files, establish a new 
circuit, and to configure your printer.

For more information, select the File menu command name.

New
Open
Save
Save As
PrintSet
Exit



Config Menu

The Config menu opens a dialog box that allows you to select the following options. 

Format
Sweep
Options
Reference Impedances



NetList Menu

The NetList menu includes commands that enable you to List or print your circuit netlist.

A scrollable Window opens listing the circuit description. Use the Scroll bars to move through
the circuit listing. To obtain a printed copy of the netlist select the system menu for the 
Netlist window, and choose the Print option to print the circuit netlist.



Start Frequency

The start frequency is the lowest frequency used for analysis.

This frequency cannot be zero.

The start frequency must be less than the end frequency.

Multipliers can be used to enter frequency values, e.g. you may enter    1 Khz as 1k or 1K , 
note 1M and 1m are not the same. 1M is one megahertz, and 1m is one milli-hertz.



End Frequency

The End frequency is the highest frequency used for analysis.

This frequency cannot be zero. 

The end frequency must be greater than the start frequency.

For a logarithmic sweep it must be at least 10 times the start frequency.

Multipliers can be used to enter frequency values, e.g. you may enter    1 Khz as 1k or 1K , 
note 1M and 1m are not the same. 1M is one megahertz, and 1m is one milli-hertz.



Number of Steps

The number of steps is the number of frequency points Aciran will calculate between the 
start and end frequency. 

he maximum number is 100, and the minimum is 1.



Number of Passes

The number of passes is the number of times Aciran will analyse your circuit during a Monte 
Carlo Tolerance analysis.

The default value is 1, i.e. no monte carlo analysis. The maximum number is 32,767.



Analyse Menu

The Analyse menu opens a frequency form with the following input fields.

Start Frequency
End Frequency
Number of Steps
Number of Passes

Some fields have minimum default values already. You must complete at least the first three 
entries.

When you are happy with the input information click the OK button or press return to start 
the analysis. 

If you change your mind press escape or click the cancel button.



Results Menu

The Results menu includes commands that enable you to display and save result files.

For more information, select the Result menu command name.

Display
File



Graph Menu

The Graph menu includes commands that enable you Plot graphs of results.

For more information, select the Graph menu command name.

Magnitude
Phase
Time Delay
Impedance
ReturnLoss
VSWR



Help Menu

The Help menu includes commands that offer help and information.

For more information, select the Help menu command name.

About
Information
Help Index
Help on Help
Help on Keyboard
Shareware (Only in Shareware Version).
Order                         (Only in Shareware Version).



Glossary

branch
clipboard
Models
Monte-Carlo
netlist
node
orcad
pspsice
returnloss
spice
vswr



Exiting

To exit Aciran and return to Windows select the Exit menu item from the File menu. 

You should save any work that is in progress.

If you select Exit without saving first Aciran will issue a warning and ask if you wish to save 
your file.



Analysing A circuit

In order to analyse a circuit you must enter a circuit from the keyboard, or load an existing 
circuit from disk.

Before analysis you should check the config dialog box to ensure that you have selected all 
the necessary parameters, such as Log or Linear frequency sweep, or Tolerance analysis.

Once satisfied chose Analyse from the main menu and enter the frequency range and 
number of frequency steps. If you wish to perform a Monte Carlo Tolerance analysis then you
must also enter the correct number of passes.

Click the OK button or press return to begin the analysis. During analysis a status window 
shows how much of the work has been completed. You can cancel the analysis at any time 
by pressing Escape or clicking on the cancel button.

If you cancel the analysis you will be given a message informing you that the analysis was 
aborted and that there are no results available.

If the analysis is successfull you will be told that all results are available.



How To Configure Aciran

There are a number of configuration options available to allow you to customise your 
analysis.

From the main chose    the config menu. 

The configuration information is stored by Aciran along with you circuit data, and therfore 
will be available each time you load the circuit. It is for this reason that you cannot select 
config until a circuit is in memory, as creating a new circuit or loading an old one resets the 
config information.



How To Print a Graph

To print a graph first get the graph of results onto the display. You can select the default 
window size or click on the maximize button to produce a full screen graph.

Select the system menu from the graph window.

This is a normal system menu with one additional item, Print is appended at the bottom. 
Select print to print the graph.

You may wish to select Printer SetUp from the File menu before hand in order to set up you 
printer to portrait or Landscape mode, or to change the printer resolution.



How To Print Results

To print results first get the window of results onto the display. 

Select the system menu from the results window.

This is a normal system menu with one additional item, Print is appended at the bottom. 
Select print to print the results.

You may wish to select Printer SetUp from the File menu before hand in order to set up you 
printer to portrait or Landscape mode, or to change the printer resolution.



How To Print a NetList

To print a netlist first get the Netlist window onto the display. 

Select the system menu from the netlist window. 

This is a normal system menu with one additional item, Print is appended at the bottom. 
Select print to print the netlist.

You may wish to select Printer SetUp from the File menu before hand in order to set up you 
printer to portrait or Landscape mode, or to change the printer resolution.



How To Select a Logarithmic Sweep

To perform a Logarithmic sweep check the Logarithmic radio button on the config dialogbox 
by selecting    config from the main menu.



How To Select a Linear Sweep

To perform a Linear sweep check the Linear radio button on the config dialogbox by 
selecting    config from the main menu.



Numbering A Circuit

The numbering convention in Aciran is that the input node is designated 1, the ground node 
is zero,    and the output node is user assigned.

As far as AC circuit analysis is concerned DC power supplies are treated as short circuits. 

This means that when numbering your circuit nodes you can short out any DC supplies by 
numbering both sides as node zero.

Aciran will accept DC voltage supplies for compatibility with other circuit analysis programs 
such as PSpice.

The DC supply is replaced by an ac short by Aciran.

You can save one node number per supply by removing the supply and grounding it. this will 
reduce the number of nodes required and speed analysis.

 Alternatively you can keep the DC supplies if you find the network topology less confusing.



Transistor Model Files

The model for the BC107 transistor used in EXAMPL2 is

BC107
2.7k
18U
192
35%
300M

The file consists of lines of text. Each line contains ONE and only one parameter and all 
parameters MUST be supplied. The information can be obtained from manufacturers data 
sheets.

The first line contains the component name 'BC107' ( max of 8 characters). Next comes the 
value of hie, followed by hoe and hfe. The tolerance value refers to hfe. Transistor hfe values
can vary enormously even for the same type of transistor. The 'h' parameters of a transistor 
vary with temperature and collector current.

Last comes the value of FT. Note the use of multipliers, hie could just have easily been 
written as 27e2, 27E2 or 2700. Transistor model files MUST be given the extension .TRN.

This is a very simple model, more complex models can be constructed using current sources 
and passive components, e.g. a Hybrid Pi model.



Fet Model Files

The Fet model file for the 2N4393 Fet used in EXAMPL6 is shown below:

2N4393
15m
45%
11.5p
2p

Again the same rules apply as for the transistor file. First comes the name, followed by the 
transconductance gm, the tolerance for gm, the Fet capacitances Cgs and Cgd. Fet model 
files MUST have the file extension .FET.



Opamp Model Files

The model file for the LM124 opamp is listed below:

LM124
100M
600
100
1M
50%

First comes the component name followed by the input impedance and the output 
impedance. Next is the open loop gain in dB and the Gain Bandwidth Product GBW. The 
tolerance refers to the open loop gain. Most opamps have a very high open loop gain in 
excess of 100dB. Manufacures data sheets give conservative values for open loop gain and 
it is well controlled.
Opamp model files MUST have the extension .AMP.



How To Create Model Files

ACIRAN uses model files to hold descriptions of 

Transistors
Fets
Opamps.

You can create your own model files and add them to the Models directory using any text 
editor or wordprocessor such as WordStar (Do not use any control codes). Details can be 
found in the Printed Manual.



How To Perform Monte Carlo Analysis

Aciran performs Monte Carlo analysis by analysing the circuit a number of times and altering
the value of component within their specified tolerance, to simulate the variation in circuit 
build found in a commercial enviroment.

To select Monte Carlo analysis set the number of passes in the frequency form to a number 
greater than one.

Aciran will then analyse the circuit that number of times.

Make sure that the tolerance check box in the config dialog box has been selected first.



Hybrid Transistor Model

The Hybrid Pi model for a Transistor is illustrated in the Printed Manual.

The symbols have the following meaning:

rbb = Base spreading resistance
rbe = Input impedance
rbc = Feedback Impedance (effect of Vce changes on Base modulation)
rce = C-E Impedance
Cc = Collector-junction barrier capacitance
Ce = Overlap diode capacitance
gm = Transistor Transconductance

If the CE 'h' parameters are known at low frequencies at a given collector current Ic (see 
manufacturers data sheets) then the impedances can be calculated in the following order:

                |Ic|            |Ic ma |
gm = ----    =    --------
            VT                26

                  hfe
rbc =    ---
                gm
 
rbb = hie - rbe

                  rbe
rbc =    ---
                  hre

                          1                                                                        1
rce =    -------------                where gbc =    ---
              hoe-(1+hfe)gbc                                            rbc
                                                                                  
The capacitance Cc is the measured CB output capacitance with the input open (Ie = 0), and
is usually specified by the manufacturers as Cob.

Ce is experimentally determined from a measurement of FT, the frequency at which the CE 
short-circuit current gain drops to unity.
                  gm
Ce =    -------        PI = 3.14159
            2*PI*FT

Typical values for a Hybrid PI model at room temperature and for Ic = 1.3mA are

gm = 50mA/V          rbb = 100 ohms            rbe = 1k          rbc = 4Mohm

rce = 80Kohm        Cc = 3pF                        Ce = 100pF



Actran Conversion Utility

It is possible to use other packages to provide input to Aciran.

The Actran conversion utility will take netlists in the Spice format and convert them into 
Aciran circuit files. Schematic capture packages such as Orcad generate netlists for PCB 
layout programs in a variety of formats, one of which is the Spice format.

Refer to the printed manual for a detailed description of how to use Actran.



Upgrade Conversion Utility

If you have been using the DOS version of Aciran prior to V3.0    ( with circuits having the 
extension *.CCT ) then you must use the Upgrade utility to convert your old files into the 
new format used by Aciran for Windows and Aciran for Dos after V 3.0.

At the dos prompt type Upgrade <filename> <return>.

Wildcards ? and * are accepted.

To convert all files in the current directory use Upgrade *.* <cr>.



Spac Conversion Utility

To increase its flexibility Actran can now make use of PSpice circuit files by means of a 
conversion utility called Spac.

Aciran now supports ( but may not actually implement ) may of the circuit elements in 
PSpice.

Spac will read PSpice circuit files and attempt to produce a corresponding Aciran circuit file. 
Refer to the printed manual for deatails.

To run type Spac <return> at the Dos prompt. 

You will be asked for the PSpice circuit file name. Full pathnames are supported.

The file standard.amp, standard.fet and standard.trn must be in the same directory as Spac. 
If the Pspice file contains include files, these must be in the same directory as Spac.



+ Edit Add Command

Add allows you to extend your circuit provided there is enough room to do so. If you had 
previously saved your circuit (which you ought to do on a regular basis) it will allow you to 
carry on building your circuit from where you left off.

You will be presented with a component selection dialog box. Check the component type you
wish to add and click OK.

A dialog box will open for the particular component type selected.

When finished adding components click cancel.



Edit Change Command

Change allows you to change a components identifier, Reference, value, tolerance, and 
nodal connections. If you wish to change the component type delete the component and add
a new one of the correct type.

A list dialog box will open listing the circuit components. Select the component to change by 
highlighting it with the cursor keys or left mouse button, and clicking OK or pressing return.

Alternitively double click on the component.

You may cancel the operation by pressing escape or clicking the cancel button.



Edit Delete Command

Delete allows the deletion of a component.

A list dialog box will open listing the circuit components. Select the component to delete by 
highlighting it with the cursor keys or left mouse button, and clicking OK or pressing return.

Alternitively double click on the component.

You may cancel the operation by pressing escape or clicking the cancel button.

You will be asked to confirm that you wish to delete the selected component.



Edit Name Command

Name allows you to change the circuit identifier (or name) of the circuit.

A dialog box will open, and if the circuit already has a name, this will be shown.

Enter a new name or cancel to abort.



Edit Output Command

Output allows you to change the output node.

 If you wish you can look at nodes internal to the circuit to see their response. In some cases 
a circuit may have more than one output node, for example a circuit with one input and two 
complementary outputs, perhaps with a constant phase shift between the two outputs.

The output node number must be an integer greater than zero and less than or equal to 100.



File Exit Command

Exit will exit from ACIRAN and take you back to Windows.

Any circuit description held in memory will be lost so make sure you have saved any data 
that you want to keep.

ACIRAN will give a warning if you have not saved your circuit and have made changes.



File New Command

New is used to enter a new circuit description to ACIRAN and as it clears any previous circuit 
from memory you should save any data that you have in memory first.

You will be given a warning first, and given the opertunity to save your work.



File Open Command

Open allows you to load a previously saved circuit for analysis or modification. Circuits are 
expected to have extension .CIR or .CTS (automatically appended by ACIRAN).

You will be presented with a Filebox. Use the cursor keys or mouse to highlight the file you 
wish to load and then press return or click the OK button.



File PrintSet Command

Printer SetUp will allow you to configure your printer, e.g. select landscape or portrait mode.



File Save Command

Save allows you to save your circuit description to disk. If you are entering a large circuit 
then you should save it periodically.



File Save As Command

Save_As allows you to save your circuit under a new name, perhaps to save a diffenent 
version. 

Save_As will be called the first time a circuit is saved as it will not have an existing filename.



Results Display Command

The Result menu's Display command is only accessible if there are results available.

A results window appears lisiting the results selected from the config dialog box

Use the scroll bar to bring into view hidden results.

To print the results, select the windows system menu, and the select Print.



Results File Command

The Result menu's Display command is only accessible if there are results available.

A file dialog box opens, enter the name of a file in which to save the results.

An ASCII file of the results will be written to disk.



Graph Magnitude Command

The Graph menu's Magnitude command is only accessible if there are results available.

A graph of Magnitude vs Frequency is displayed.

You can maximize or minimize the graph, or move it around the screen.

To print the graph, select the windows system menu, and the select Print.



Graph Phase Command

The Graph menu's Phase command is only accessible if there are results available.

A graph of Phase vs Frequency is displayed.

You can maximize or minimize the graph, or move it around the screen.

To print the graph, select the windows system menu, and the select Print.



Graph Delay Command

The Graph menu's Delay command is only accessible if there are results available.

A graph of Time Delay vs Frequency is displayed.

You can maximize or minimize the graph, or move it around the screen.

To print the graph, select the windows system menu, and the select Print.



Graph Impedance Command

This menu offers a choice of Input or Output impedance. Select the one you want.

The Graph menu's Impedance command is only accessible if there are results available.

A graph of Input Impedance or Output Impedance vs Frequency is displayed.
The format will be either Polar or Cartesian, depending on the config setup.

Two graphs will be displayed. (one may be under the other.)

The first graph will show either the Magnitude or Real part of the impedance.
The second graph will show either the Phase or Imaginary part of the impedance.

You can maximize or minimize the graph, or move it around the screen.

To print the graph, select the windows system menu, and the select Print.



Graph ReturnLoss Command

This menu offers a choice of Input or Output ReturnLoss. Select the one you want.

The Graph menu's ReturnLoss command is only accessible if there are results available.

A graph of Input ReturnLoss or Output ReturnLoss vs Frequency is displayed.

You can maximize or minimize the graph, or move it around the screen.

To print the graph, select the windows system menu, and the select Print.



Graph VSWR Command

This menu offers a choice of Input or Output VSWR. Select the one you want.

The Graph menu's VSWR command is only accessible if there are results available.

A graph of Input VSWR or Output VSWR vs Frequency is displayed.

You can maximize or minimize the graph, or move it around the screen.

To print the graph, select the windows system menu, and the select Print.



Help About Command

Thie About command displays a Copyright notice and the current version of Aciran for 
Windows.



Help Information Command

The Information command gives details of the maximum number or nodes, components and 
frequency steps allowed by Aciran.

It also gives information on the amount of free memory and disk space available, and 
whether or not Aciran has detected a co-processor.



Help Index Command

This option will take you straight into the help index fro Aciran's online context sensitive 
Help.



Help on Help Command

This    explains    Help on how to use the Help facility.



Help Keys Command

This explains the way different keys are used in Windows, and also in Help.



Help Shareware Command

This Help topic explains the Shareware principle and reminds users that they must register 
this program if they intend to use it. (This menu item is only in the Shareware version)



Help Order Command

This menu item explains how to order your registered copy of Aciran.



Context Sensitive Topics

This Help system includes topics that you can call directly. To get context-sensitive help from
Aciran, press Shift+F1 and click on any element of the Aciran application window. You can 
also highlight any Aciran menu command using the keyboard and press F1 to get help on the
command. 



Main Window

The Main window in Aciran acts as a focal point for the whole program.

You can shrink it to an Icon or maximize it to full screen.

Aciran will remember the size and position of its main window from one session to the next.

You can switch to other programs and Aciran will continue to run in the background.

You can even run multiple instances of Aciran, although you may find things slow down 
during analysis.

Remember each instance requires substantial memory.



Maximize Icon

The maximize icon causes the window to occupy the entire screen.



Minimize Icon

The minimize icon causes the window to shrink to an icon. The icin can be dragged around 
the screen using the mouse.

Double click the icon to restore the window.



Sizing Border

The sizing border that surrounds the application window allows you to resize the window.

Select the border, the mouse cursor changes to a two headed arrow. Hold down the left 
button and drag the border to a new position. Release the mouse button and the window will
be redrawn.



System Menu

The system menu allows you to change the size and position of the window, or switch to a 
new task or end the current one.

In some Aciran windows, it also allows you to print the contents of the window.



Title Bar

The title bar that is used for application and document windows shows the name of the 
application.

You can use the title bar to move a window.

Place the mouse cursor on the tilte bar and hold down the left mouse button. You can now 
drag the window to a new screen location. Release the mouse button and the window is 
redrawn in the new postion.





Windows Keys

The keyboard topics below come from Help for Windows.    Choose from the following list to 
review the keys used in Windows:
Cursor Movement Keys
Dialog Box Keys
Editing Keys
Help Keys
Menu Keys
System Keys
Text Selection Keys
Window Keys



Cursor Movement Keys

Key(s) Function

DIRECTION key Moves the cursor left, right, up, or down in a field.
End or Ctrl+Right Arrow Moves to the end of a field.
Home or CTRL+Left Arrow Moves to the beginning of a field.
PAGE UP or PAGE DOWN Moves up or down in a field, one screen at a time.



Dialog Box Keys

Key(s) Function

TAB Moves from field to field (left to right and top to bottom).
SHIFT+TAB Moves from field to field in reverse order.
ALT+letter Moves to the option or group whose underlined letter matches 

the one you type.
DIRECTION key Moves from option to option within a group of options.
ENTER Executes a command button.

Or, chooses the selected item in a list box and executes the 
command.

ESC Closes a dialog box without completing the command. (Same as
Cancel)

ALT+DOWN ARROW Opens a drop-down list box.
ALT+UP or DOWN ARROW Selects item in a drop-down list box.
SPACEBAR Cancels a selection in a list box.

Selects or clears a check box.
CTRL+SLASH Selects all the items in a list box.
CTRL+BACKSLASH Cancels all selections except the current selection.
SHIFT+ DIRECTION key Extends selection in a text box.
SHIFT+ HOME Extends selection to first character in a text box.
SHIFT+ END Extends selection to last character in a text box



Editing Keys

Key(s) Function

Backspace Deletes the character to the left of the cursor.
Or, deletes selected text.

Delete Deletes the character to the right of the cursor.
Or, deletes selected text.



Help Keys

Key(s) Function

F1 Gets Help and displays the Help Index for the application. If the 
Help window is already open, pressing F1 displays the "Using 
Windows Help" topics.
In some Windows applications, pressing F1 displays a Help topic
on the selected command, dialog box option, or system 
message.

SHIFT+F1 Changes the pointer to {bmc helpicon.bmp} so you can get 
Help on a specific command, screen region, or key. You can then
choose a command, click the screen region, or press a key or 
key combination you want to know more about.
(This feature is not available in all Windows applications.)



Menu Keys

Key(s) Function

Alt Selects the first menu on the menu bar.
Letter key Chooses the menu, or menu item, whose underlined letter 

matches the one you type.
Alt+letter key Pulls down the menu whose underlined letter matches the one 

you type.
LEFT or RIGHT ARROW Moves among menus.
UP or DOWN ARROW Moves among menu items.
Enter Chooses the selected menu item.



System Keys

The following keys can be used from any window, regardless of the application you are 
using.

Key(s) Function

Ctrl+Esc Switches to the Task List.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+TAB Switches to the next application window, restoring applications 

that are running as icons.
Alt+PrtSc Copies the entire screen to Clipboard.
Ctrl+F4 Closes the active window.
F1 Gets Help and displays the Help Index for the application. (See 

Help Keys)



Text Selection Keys

Key(s) Function

SHIFT+LEFT or RIGHT ARROW Selects text one character at a time to the left 
or right.

SHIFT+DOWN or UP Selects one line of text up or down.
SHIFT+END Selects text to the end of the line.
SHIFT+HOME Selects text to the beginning of the line.
SHIFT+PAGE DOWN Selects text down one window.

Or, cancels the selection if the next window is 
already selected.

SHIFT+PAGE UP Selects text up one window.
Or, cancels the selection if the previous 
window is already selected.

CTRL+SHIFT+LEFT or RIGHT ARROW Selects text to the next or previous word.
CTRL+SHIFT+UP or DOWN ARROW Selects text to the beginning (UP ARROW) or 

end (DOWN ARROW) of the paragraph.
CTRL+SHIFT+END Selects text to the end of the document.
CTRL+SHIFT+HOME Selects text to the beginning of the document.



Window Keys

Key(s) Function

ALT+SPACEBAR Opens the Control menu for an application window.
ALT+Hyphen Opens the Control menu for a document window.
Alt+F4 Closes a window.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+TAB Switches to the next application window, restoring applications 

that are running as icons.
Alt+ENTER Switches a non-Windows application between running in a 

window and running full screen.
DIRECTION key Moves a window when you have chosen Move from the Control 

menu.
Or, changes the size of a window when you have chosen Size 
from the Control menu.





Clipboard

This is a topic that describes the Windows term "clipboard". If you click the "clipboard" term 
within the Copying Text or Glossary topic, this Help topic will be displayed in a pop-up 
window.

This topic is also tagged with the keyword "clipboard," for use with the WinHelp Search 
option.



Node

In order to describe an electronic circuit to a computer the normal convention is to place numbers at each 
interconnection point or node. 

The circuit is then described in terms of node numbers, and the components that lie between the node 
numbers are termed branch components. 



Branch

A branch in an electronic circuit is the path between two connections or nodes.



Spice

Spice is a circuit analysis program originally written in FORTRAN and run on a mainframe. The program 
used simple text file as a means of inputting a circuit description to the computer. Spice is very powerful, 
capable of handling DC, Transient and Fouriers analysis. It is however not very user friendly.



PSpice

PSpice is a powerful circuit analysis program, the PC equivalent of Spice. It is written in C and usually 
requires you to have a co-processor fitted. 



Orcad

Orcad is a proprietary Schematic capture tool used in the layout of electronic circuits. The schematic 
capture program can be used to produce Netlists in a number of formats.



VSWR

VSWR stands for Voltage Standing Wave Ratio. It is a means of measuring how good or bad a match 
exists in an electronic circuit by measuring the ratio of an incident wave to it reflection.

A VSWR value of one indicates a perfect match.



ReturnLoss

ReturnLoss is another way of looking at VSWR. It is a means of measuring how good or bad a match 
exists in an electronic circuit by measuring the ratio of an incident wave to it reflection, in terms of a dB 
ratio.

The higher the dB ratio, the better the match.



NetList

A NetList is a means of describing the interconnection of an electronic circuit in a format than can be read 
by a computer. This can be in the form of a text or binary file. In text files, such as those used by Pspice, 
the file contains information about the component types, and their interconnections.



Monte Carlo

Monte Carlo is a statistical technique whereby a computer tries to simulate occurrances found in the real 
world by randomly varying data within predetermined limits, and then performing a large number of 
repeated analysis to try and find a trend in performance.



Models

Models are a means of describing to a computer program some aspect of the real world, in order that a 
computer simulation can be performed. In electronic analysis the model normally consists of an 
equivalent circuit of a component or device, which is described (modelled) in terms of simpler baisi 
building blocks.




